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Document Version Control 

Date Doc Version Number Changes 

8/10/15 1.00.00 Document Created, 1.0 
application release 

9/21/15 1.00.01 Added USFS device installation 
instructions. 

12/14/15 1.01.00 Updated doc with changes in 
release 1.1 

2/2/16 1.01.01 Updated install instructions to 
include app upgrade info 

2/24/16 1.01.02 Replaced broken links in USFS 
install instructions 

3/14/16 2.00 Updated to reflect version 2.0 
changes 

8/16/16 2.00.01 Updated sections regarding BLM 
Remedy install request 

9/30/16 2.30.00 Updated screenshots to reflect 
new app color scheme & 2.3 
changes 

About 
The S1 Mobile application is a custom application built by the Service First (S1) Mobile GIS team, 

sponsored by Oregon State Office Bureau of Land Management and Region 6 US Forest Service. The 

application is designed to extend offline mobile field data collection capabilities not available using 

commercial ESRI mapping applications and to meet the specific data collection needs of the federal 

agencies served by the OR/WA Service First Mobile GIS program. It is currently built to run on a mobile 

device running Android operating system, using the ESRI Runtime Software Development Kit (SDK) 

framework. It leverages each agency’s ArcGIS for Organization site as well as their internal ArcGIS Server 

deployments to distribute and collect enterprise geographic information systems (GIS) information via 

agency field personnel. 

Because agency field personnel operate most commonly in remote areas with no network access, this 

application’s emphasis is on the display, collection & update of geospatial data and attributes with no 

network availability. Data is downloaded and cached on device, edits can be uploaded to servers when 

network connectivity is available & it is most convenient for field personnel. 

For a full list of application capabilities, or application installation instructions, See the Application 

Capabilities or Installation sections. 

For more background about the application itself, go to the application’s website: 

https://www.blm.gov/or/gis/mobile/s1mobile/ 

https://www.blm.gov/or/gis/mobile/s1mobile/
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Launching Application 
The application is launched by tapping on the application icon found on the device’s list of applications. 

 

Logging into Application 
You must be in a connected environment (Wi-Fi or Cellular) when logging into and authorizing the 

application. Once logged in, those AG4O credentials are then stored on the device; it is only necessary to 

be in a connected environment when uploading, downloading or synchronizing data, or re-

authenticating the application with AG4O.  

 To Log in and authenticate the application, choose Agency you work for: 

 

 Enter your agency ArcGIS for Organization (AG4O) user name and password. This is different 

than your Agency AD user name and password. Tap Sign In: 

 

All applications based on the ESRI Runtime SDK must be authenticated with AG4O every 30 days. The 

application will alert you when this time has passed. Failure to authenticate the application every 30 

days may result in reduced application capability until the application is re-authenticated. 
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Downloading Default Base Map 
A default base map will be added to the map view after the application is initially authenticated. This is 

high level base map to orient new users, but most users will prefer to download their own base maps 

with a greater level of detail for their area of interest.  

 When added to map view, Default (High-Level) Base Map appears: 

 

To download your own detailed Base Maps, see Downloading Content. 
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Application Interface 
 

 

Application Toolbar 

 

Activate GPS 

 

 Tap GPS Icon to turn on GPS, tap a second time to turn it off 

 Once GPS position fix is obtained, location will show on map as a blue dot 

 When GPS is turned on, the GPS Position toolbar appears at top of screen, which displays: 

a. Current GPS location coordinates 

b. Number of satellites used in position fix 

c. Estimated accuracy (in meters) 

d. GPS Source/Quality (No Fix, GPS, DGPS, RTK) 
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 GPS location coordinates are displayed in decimal degrees WGS84 by default, but can be 

changed to other coordinate systems by tapping on the GPS Position toolbar and selecting 

another coordinate system from the list; this can also be changed in S1 Options. 

 

 Estimated accuracy is displayed to a 68% confidence interval, can be changed to display 

estimated accuracy 95% confidence interval in S1 Options. The default accuracy units are metric, 

but this can also be changed in S1 Options. 

 It is advised to set your device’s Android Location setting to GPS only for the highest possible 

spatial location accuracy. The application will check when this tool is activated and alert you if 

the device is set to any other Android Location setting. 

 It is possible to connect an external, high accuracy GPS receiver to provide location information 

to the app instead of using the device’s internal GPS. For more information on this topic, see 

External Bluetooth GPS Receiver Support section. 

Collect Features 

 

 Tap to capture new map features 

 Choose from: 
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a. S1 Waypoints 

b. Layers in the map’s current edit geodatabase 

  

 See Collecting New Features section for detailed information about capturing new map 

features and attributes 

 Edit geodatabase can be added to map using the Manage Map Layers tool 

Manage Map Layers 

 

 S1 Mobile displays maps, layers and databases that have been downloaded to the device 

 There can be one of each in the application’s current map view, see links for more info 

about each type of data source: 

o Base Map 

o User Reference Map 

o Edit Geodatabase  

 

 This form reports which downloaded layers are featured in the current map view  

 Can be used to change one or more of these layers in the current map view 

 Can also be used to delete content from local storage of device 

 Deleting of Edit GDB requires network connectivity 

 See Managing Downloaded Content for more information 
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Tools/Options Menu 

 

 Tapping the button produces the following menu : 

 

 To learn more about synchronizing edit data, see Sync Data Edits to Server 

 To learn more about downloading data to the device, see Downloading Content to S1 Mobile 

 To learn more about the application’s various tools, see Tools 

 To learn more about S1 Application Options, see Application Options 
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About S1 Menu 

 

 Tapping button produces the following menu: 

 

 Tapping Help opens this document in PDF form on the mobile device 

 Tapping Quick Help opens a Quick Reference PDF guide 

 Tapping About produces a pop up showing the current installed version number, application 

description, privacy policy and end-user license agreement (EULA): 
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Downloading Content 
The S1 Mobile application can download and store base maps, user reference maps and edit 

geodatabases to the mobile device, so that the user of the application can interact with maps and 

collect data when in areas of limited or no connectivity. 

Base Maps 
This section describes how to obtain Base Maps for offline consumption with the S1 Mobile application.  

Base Maps, as the name suggests are the foundational map layer of the S1 Mobile application. These are 

multi-scale tiled image cache packages (.tpk), which quickly display image tiles appropriate for the 

current map scale. They are downloaded to mobile devices over Wi-Fi or cellular networks or can be 

manually copied (“side loaded”) to a mobile device via Windows Explorer. 

Base Maps are typically authoritative reference maps, and can be sourced commercially (ESRI 

ArcGIS.com) or produced and distributed by the BLM or USFS. S1 Mobile application can store many 

Base Maps on a device at a time, and the user can switch between them to set the appropriate Base 

Map for their current viewing needs. 

S1 Mobile application immediately downloads a high level “wire frame” Default Base Map when the 

application is first installed. Unlike other user-downloaded Base Maps, the Default Base Map cannot be 

deleted from the device. 

Assumptions for Downloading Base Maps: 

 S1 Mobile Application open on Android device 

 A 4G or Wifi network connection 

Download ESRI Base Maps 

 Tap Tools/Options button 

 

 Tap Download Data 
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 Tap Download ESRI Base Map 

 

 Choose a Base Map from the list of available ESRI Base Maps 

 

 You can have multiple downloads on a device from same ESRI Base Map, each with their own 

different extents and zoom levels. Add a unique name to describe this download. 
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 Use top map view to set the maximum map extent, use slider on bottom to set max level of 

detail (LOD). Very large extents may constrain your ability to download a deep level of detail. 

The application will reported estimated download size as you adjust the LOD slider. 

 

 Tap download button to initiate download. 

 

 Track the download progress in the notification panel. When download is complete, map is 

automatically added to map view as the current Base Map. 
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Download Agency (BLM or USFS) Base Map 

 Tap Tools/Options button 

 

 Tap Download Data 

 

 Tap Download Agency Base Map 
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 Choose a Base Map from the list of available Agency Base Maps. If the selected content is a pre-

configured Base Map in tile package (.tpk) format, the download will begin immediately. If the 

selected content is a tiled mapping service Base Map, continue with instructions below to set 

the extent and zoom level. 

 

 You can have multiple downloads on a device from same agency Base Map, each with different 

extents and zoom levels. Add a unique name to describe this download. 
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 Use top map view to set the maximum map extent, use slider on bottom to set max level of 

detail (LOD). Very large extents may constrain your ability to download a deep level of detail. 

The application will reported estimated download size as you adjust the LOD slider. 

  

 Tap download button to initiate download 

 

 Track the download progress in the notification panel. When download is complete, map is 

automatically added to map view as the current Base Map. 
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User Reference Map 
In S1 Mobile, users can add a user reference map to display on top of the existing base map. This user 

reference map can be either a multi-scale ESRI tile package (.tpk) or a single geo-referenced GeoTIFF 

image file. User reference maps can be shared and downloaded to mobile devices via ArcGIS for 

Organization (AG4O) over Wi-Fi or cellular networks. They can also be manually copied to a mobile 

device via Windows Explorer. 

Downloading User Reference Map to Device 

Assumptions: 

 S1 Mobile application open on Android device 

 A 4G or Wi-Fi network connection 

 User Reference Maps uploaded to AG4O and shared with a group you are a member of 

 

 Tap Tools/Options button 

 

 Tap Download Data 

 

 Tap Download User Reference Map 
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 A list of AG4O groups that you are currently a member of will appear. Tap on the group that the 

desired User Reference Map is a part of.  

  

 A list of User Reference Map will appear, tap on the one that you wish to download. 

  

 Download will begin. When download reaches 100%, the layer is added to the map view as the 

current User Reference Map.  
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Copy User Reference Map to Device via Side Loading 

While sharing reference maps via AG4O is often the easiest way to distribute user generated reference 

data to multiple devices, if the map content is very large or network connectivity is unreliable, it can 

take a long time to download to a device. An alternative is to instead connect the device to a PC via USB 

cable and to use Windows Explorer to side load the user reference maps directly onto the device’s SD 

card. 

Assumptions: 

 Android Device with SD Card installed 

 S1 Mobile application installed 

 USB cable 

 Reference Map already created 

Copy User Reference Map to Mobile Device 

 Using Windows Explorer, navigate to the network location where the tile package or geo-

referenced GeoTIFF resides. Right click on the file and choose Copy.  

 Connect Device to computer via USB cable. 

 Using Windows Explorer, navigate to the following directory on your connected Android device.  

…\Card\Android\data\gov.s1.s1mobile\Reference_Data 
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 Double click on the folder Local_Ref_Maps to open it. This is the directory where all downloaded 

and side loaded User Reference Maps must reside.  

 Click on Organize -> Paste to copy/paste the file into this directory. 

Add User Reference Map to Application Map View 

When downloading from AG4O, the User Reference Map is automatically added to the map view when 

the download has completed. If data is side loaded, one must manually add the User Reference Map to 

the map view. 

The S1 Mobile Manage Map Layers button allows you to add/change one of these to a different 

reference map that is currently stored on the device. See Managing Downloaded Content for more 

information. 

Download Edit Geodatabase (GDB) 
Assumptions: 

 S1 Mobile application open on Android device 

 A 4G or Wifi network connection 

 Published Feature Service with Sync capability enabled 

 User has edit rights to access to feature service (if it is secured) 

About Edit GDB Extent 

Each edit GDB has a maximum extent; no features can be collected beyond the area set by this extent. 

The extent is set when the edit GDB is downloaded to the device. 

Downloading Edit GDB to Device 

 Launch S1 Mobile application, zoom map view to desired maximum extent. This will define the 

maximum data collection area for the downloaded data set. 

 Tap Tools/Options button 
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 Tap Download Data 

 

 Tap Download Edit Geodatabase 

 

 A list of AG4O groups that you are currently a member of will appear. Tap on the group that the 

desired feature service to be downloaded is shared with.  
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 A list of Feature Services will appear, tap on the one that you wish to download into an Edit 

GDB. 

 

If the Feature Service resides on internal Agency ArcGIS 10.3 servers: enter Agency Active Directory (AD) 

credentials. User name credentials should be entered as: BLM\username (for BLM) or DS\username (for 

USFS), using your Agency user name and enter your Windows AD password. Tap Login to submit 

request. 

  

If the Feature Service is an ESRI hosted Feature Service, no log in credentials are required. 

 Set the extent of the edit geodatabase by zooming and panning the map view. All features that 

fall within the extent of the current map view will be downloaded to the device. 
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 When extent is set, tap the download button to begin the download process. 

 

Download will begin. While the download is underway, a progress circle will display on the toolbar.  

 

Edit GDB layers are added to the map view when download is complete. The length of this process 

depends on the size of the extent downloaded and the number of features present in the download 

area extent. A pink rectangle will document the maximum extent of this edit GDB. No data can be 

collected outside this extent. 
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 You can start collecting features into this database by tapping the Collect Features button. 

 

Sync Data Edits to Server 

After features have been collected or modified, edits can be sync’d back to the server when the device 

has network connectivity.  

Synchronization requires either a 4G or a WiFi connection; 3G or slower connections cannot support 

synchronization. It is strongly advised syncing occur on a reliable WiFi connection whenever possible. 

 Tap Tools/Options button 

 

 To sync changes, tap Sync Data. The number of edits to be synchronized will be displayed next 

to Sync Data. 
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 The duration of the sync process will be determined by network connectivity and the number of 

records that are being synchronized. While the synchronization process is underway, a progress 

circle will display on the toolbar. 

 

 When the process has completed, the progress circle will disappear and the following message 

will appear at the bottom of the screen:  Sync Completed without Errors. 

 After synchronization, the number of changes to be sync’d resets to zero. 

 

Managing Downloaded Content in Map View 
The application map view can support the display of a base map, a user reference map and an edit 

geodatabase. Users can switch out one or more of these with other locally stored base maps, user 

reference maps or edit geodatabases using Manage Map Layers. User Reference Maps and Edit GDB 

must fall with in the current Base Map extent in order to be added to the Map View. 

 Click on the Manage Map Layers icon. 
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The current map content is listed on the form. To change to a different content, tap the thumbnail to 

the right of that map content. 

 

Switch Current Content in Map View 
 Tap the thumbnail to the right of Base Map, User Reference Map, or Edit Geodatabase. A list of 

all Base Maps (tile packages) or User Reference Map (tile packages & geo-referenced images) or 

Edit Geodatabases stored on device will appear as thumbnails. 

  

 To add content to your map, tap its thumbnail. User Reference Maps draw on top of the Base 

Map.  Edit Geodatabases draw on top of all other map content.  

 In order to add User Reference Maps or Edit GDB to your current map view, they must be within 

the extent of the current Base Map. If they are not, they cannot be added to the current map 

view without first changing the current Base Map. 

 In order to collect or sync edit data in an edit geodatabase, it must be present in the map view.  
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Remove Layer from Map and Delete from Device 
 To remove a layer from the current map view, long tap on the thumbnail and choose Remove 

Layer. This only removes it from the current map view. It does not delete it from the device. 

  

 To permanently remove a layer from the device, long tap on the thumbnail and choose Delete 

Layer from Device. This will remove it from the map view (if necessary) and permanently delete 

the layer from the device memory.  

 If this is an edit geodatabase, you must have network connectivity prior to deleting an edit GDB. 
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 If this is an edit geodatabase, all edits should be sync'd prior to deleting the geodatabase from 

device. If not, edits will be lost. 

Collecting New Features 
Assumptions: 

 Edit GDB has been downloaded to device covering the desired data collection area extent 

 Edit GDB is set as the current Edit Geodatabase in Manage Map Layers 

 

 

To start collecting new map features: 

 Tap the Collect Features button 
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 Choose the layer to collect a new feature. Your data collection workflow will be dictated by 

geometry type of layer you choose here 

Collecting New Point Feature via GPS 
 If not already activated, turn on GPS by tapping GPS button 

 Wait until strong position fix before proceeding 

 Tap the Average GPS button to capture an averaged GPS position for your feature 

 

 Averaging status appears at the bottom of the screen in the Position Capture Status bar, 

application captures # of vertices based on S1 Application Options settings. 

  

On tablets, the attribute data entry pane will already be visible on screen; attribute data entry can occur 

simultaneously with geometry capture. On smaller devices, the attribute view must be initiated by 

tapping the Attribute View Toggle button. This button allows the user to switch back & forth between 

map & attribute view on smaller devices, or to minimize the attribute view on tablet sized devices. 

 

 Tap Commit Edit button on Edit Toolbar to save geometry & attributes data entry 

 

Collecting New Point Feature via Digitizing/Draw on Screen 
 If GPS is activated, turn off GPS by tapping GPS button 

 Tap on screen at location where point is to be created, red dot will appear 

On tablets, the attribute data entry pane will already be visible on screen; attribute data entry can occur 

simultaneously with geometry capture. On smaller devices, the attribute view must be initiated by 

tapping the Attribute View Toggle button. This button allows the user to switch back & forth between 

map & attribute view on smaller devices, or to minimize the attribute view on tablet sized devices. 
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 Tap Commit Edit button on Edit Toolbar to save geometry & attributes data entry 

 

Collecting New Line or Area Feature via GPS 
 If not already activated, turn on GPS by tapping GPS button 

 Wait until strong position fix before proceeding 

GPS Streaming 

 Tap the Begin Streaming button to start recording GPS positions for your feature and start 

moving 

 

 Feature vertices will be captured based on interval settings specified in S1 Application Options, 

total number of positions recorded will be displayed in the Position Capture Status bar 

 

 To temporarily suspend capturing vertices via streaming, tap the Pause Streaming button 

 To optimize application performance,  do not capture more than 5,000 streaming positions  in a 

continuous streaming session 

 

On tablets, the attribute data entry pane will already be visible on screen; attribute data entry can occur 

simultaneously with geometry capture. On smaller devices, the attribute view must be initiated by 

tapping the Attribute View Toggle button. This button allows the user to switch back & forth between 

map & attribute view on smaller devices, or to minimize the attribute view on tablet sized devices. 

 

 After line or area is fully captured, tap Commit Edit button on Edit Toolbar to save geometry & 

attributes data entry 
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GPS Averaged Vertex 

 Stand at the start or the line feature or edge of the area feature, then tap Average GPS button 

to capture first vertex 

 

 Averaging status appears at the bottom of the screen in the Position Capture Status bar, 

application captures # of vertices based on S1 Application Options settings 

 

 When averaging is complete, move to the next location along the line or area perimeter; tap 

Average Vertex button to capture another vertex at this location. 

On tablets, the attribute data entry pane will already be visible on screen; attribute data entry can occur 

simultaneously with geometry capture. On smaller devices, the attribute view must be initiated by 

tapping the Attribute View Toggle button. This button allows the user to switch back & forth between 

map & attribute view on smaller devices, or to minimize the attribute view on tablet sized devices. 

 

 After line or area is fully captured, tap Commit Edit button on Edit Toolbar to save geometry & 

attributes data entry 

 

GPS Toggle between Stream & Averaged Vertex 

It is possible to toggle data collection between GPS streaming and GPS Averaged Vertex when collecting 

lines or areas. As an example: 

 Start collecting line or area via GPS Streaming (Begin GPS Stream button) 

 To switch into Averaged Vertex mode, tap Pause GPS Stream, move to location to place 

Averaged Vertex 

 Tap Average Vertex button and collect position 

 To return to GPS Streaming, tap Begin GPS Stream button again 

 Finish spatial and attribute data collection as you would on other collection work flows 
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Collecting New Line/Area Feature via Digitizing/Draw on Screen 

 If GPS is activated, turn off GPS by tapping GPS button 

 Tap on screen at location where line or area is to begin, red dot will appear 

 Tap again on screen to place second vertex location, second dot will appear and line connects 

two vertices 

 Continue tapping on screen to draw line or area feature 

On tablets, the attribute data entry pane will already be visible on screen; attribute data entry can occur 

simultaneously with geometry capture. On smaller devices, the attribute view must be initiated by 

tapping the Attribute View Toggle button. This button allows the user to switch back & forth between 

map & attribute view on smaller devices, or to minimize the attribute view on tablet sized devices. 

 

 After line or area is fully captured, tap Commit Edit button on Edit Toolbar to save geometry & 

attributes data entry 

Repeating Attributes 
When collecting many features that share the same set of attribute values, it may be beneficial to 

enable the Repeat Attributes option, available at the bottom of the attribute data entry form. This 

capability is turned on once per GDB layer, and will persist from session to session for GDB layer until it 

is turned off. When enabled, subsequent new features collected into this same layer will have the 

attributes pre-populated from the previously collected feature. Unique attribute value fields (primary 

keys, GUID values, editor tracking fields, etc) are never repeated. Attributes can be changed before 

saving subsequent features. Repeat Attributes is turned off by default. 

 



 
 

S 1  M o b i l e  A p p l i c a t i o n  f o r  A n d r o i d  2 . 3  
 

Page 37 

Related Records Data Entry 
If the feature service supports related tables, S1 Mobile application can create, edit & delete related 

records into its offline edit GDB. The application supports the following relationship types: feature to 

feature, feature to table, table to table & relates of relates. Relationships must be constructed using 

both a GLOBALID or GUID field as the primary key field type and a GUID field as the foreign key field. 

When a relationship exists between two tables, a list box will appear on the parent feature class/table’s 

attribute edit form for each relationship class. The name of the relationship class appears as a title 

above the list box. Existing related records appear inside the list box. 

 

 New related records can be created by tapping Add 

 Existing related records can be queried or edited by highlighting the related record in question 

and tapping Edit 

 Existing related records can be queried or edited by highlighting the related record and tapping 

Delete 

 Existing related records can be copied or duplicated by long tapping on the record to be 

duplicated and choosing Copy record; doing so will create a duplicate record in the related table 

with the same attributes as the original, attributes can be modified on the duplicated record 

prior to saving.  
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Editing Existing Features 
Assumptions: 

 Edit GDB has been downloaded to device covering desired data collection area 

 Edit GDB is set as the current Edit Geodatabase in Manage Map Layers 

 There are existing features in this Edit GDB to edit 

To edit an existing feature it must be selected: 

 Tap on screen to select a map feature. A feature’s symbol, when selected is highlighted in the 

map view. 

 A blue Feature Info bar will appear listing the name of the selected feature. 

 If multiple features were selected at the same time, swipe the blue feature bar left or right until 

the desired feature is selected 

 

 Tap the blue Feature Info bar to display the Feature Info pop up 
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 The feature Info pop up can be closed using the device’s back button. Feature remains selected 

even after pop up is closed. 

 Once feature is selected, tap the Edit Feature button on the Selection Toolbar to begin editing 

the selected feature 

 

Edit Mode Toolbar 
While in edit mode, the Edit Toolbar will appear on screen: 

 

 Submit Edit 

 Attribute View Toggle 

 Cancel Edit 

 Delete Feature 

Editing Feature Geometry 
Geometry edits are made on a single selected feature at a time. All edits must be saved via Submit Edit 

button in order to be made permanent; prior to saving changes can be rolled back using the Cancel Edit 

button.  

Editing Point Geometry 

The feature will be automatically selected on screen via red dot while in edit mode. 

Via GPS 

 If not already activated, turn on GPS by tapping GPS button 

 To change its location to the current GPS location, tap the Average GPS button 

 
 The red dot will move to the current GPS location after averaging its position 

 To edits any attributes, follow instructions below 
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 To commit the change and stop editing the feature, tap the Submit Edit button 

 

Via Digitizing Manually on Screen 

 To move the feature’s location, tap that location on screen. 

 The red dot will move to that location. 

 To commit the change and stop editing the feature, tap the Submit Edit button 

 

Editing Line or Polygon Geometry 

The feature will be automatically selected on screen and the individual vertices are displayed as large 

black dots. In edit mode, users can reshape the feature using GPS or by dragging vertices around the 

map using a finger. 

 

Via GPS 

 If not already activated, turn on GPS by tapping GPS button 

 In order to reshape the line or polygon feature using GPS, first tap the vertex where the 

reshaping is to be initiated from, a red dot will appear there when it has been selected. 
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 To begin reshaping the line or polygon, tap the Begin Streaming button to start recording 

updated GPS positions and start moving 

 

 As you move, the existing feature will adjust to match the updated GPS positions 

 Just like new data capture, it is possible to pause capture and to capture using averaged 

vertices, see Collect New Line or Area via GPS for options 

 To end reshaping the feature and commit the changes, tap the Submit Edit button 

 

 If reshaping is occurring in the middle of a feature, the end of the reshape line will snap back to 

the next closest vertex in the feature being edited 

Via Digitizing Manually on Screen 

 The existing vertices will be shown on screen as large black dots. To move a vertex, tap and drag 

it to a new location on the map. 

   

 The vertex will move and the feature will automatically reshape itself 

 To insert additional vertices, tap and drag  the green circle in between two existing vertices to a 

new location, a new black vertex will appear when you release 
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 To commit the change and stop editing the feature, tap the Submit Edit button 

 

Editing Feature Attributes 
 The feature should already be selected and the Edit Feature button on the Selection Toolbar 

should already be enabled, if not do so 

 Tap on the Edit Attributes button on the edit toolbar to display attribute view, if it is not already 

visible 

 
 Make any changes necessary then tap Submit Edit button to commit the changes 

 To delete a selected feature, tap Delete Feature on the Selection Toolbar 

 

 To edit the photo attachments associated with the selected feature, see Managing Existing 

Photo Attachments 

Collecting Photo Attachments 
Photos can be attached to features of any edit geodatabase that supports feature attachments. Photos 

can be taken by the device camera and inserted as an attachment or an existing JPEG image on device 

can be used to create the attachment. There is no limit to the number of photo attachments that can be 

associated with any one feature, but the more photos taken, the longer uploads will take to process 

back to the database at synchronization time. 

Collecting Photo Attachments 
 To capture a photo attachment while collecting a new feature, tap the Attachment button 
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 Tap Take Pic to initiate the camera tool or Browse to search for existing images on device 

 If using Camera, frame subject , snap photo and tap the Save  button  

 If browsing the device, choose an image from the Image Gallery shown on screen 

 Repeat process to add as many photo attachments as required 

 Thumbnails of the associated photo attachments will display on screen, tap Done when finished 

 

 New photos will appear as + Photo(s) records to be synchronized back to the database under 

the Sync Data view in Tools/Options menu: 

 

Managing Existing Photo Attachments 
 To review existing attachments of a feature, the feature must be selected on screen 
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 Once feature is selected, tap the Attachment button 

 

 The Attachment Form displays a list of all attachments currently associated with this feature.  

 To view the photo in full screen view, tap on the thumbnail and choose an application to Open 

With from the pop up menu 

 To delete an attachment, long tap on the thumbnail and choose Remove Attachment from the 

pop up menu 

 To close the Photo Attachments form, tap Done 

If there are many existing photo attachments, it may take several seconds before the existing photos 

and their thumbnails appear onscreen when Add Attachment form is first opened. 

S1 Waypoints 
S1 Mobile allows user to capture simple point locations on the device. These are called S1 Waypoints. 

The application will store the spatial location of a waypoint, along with a basic description field that is 

assigned by the user when point is created. While no substitute for an edit geodatabase, it can be an 

easy way to capture a quick X,Y location on the map. These waypoints are stored in the coordinate 

system WGS_1984_Web_Mercator_Auxiliary_Sphere. 

Collecting S1 Waypoint 
 To collect, tap Collect Features button. 

 

 Choose S1 Waypoint from list 

Waypoint location can be captured via digitizing/drawing on screen or via Averaged GPS, in the same 

manner as collecting feature points described above. 

 After geometry is saved, populate the description field and tap Commit Edit to store the GPS 

Waypoint on device. 
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 Waypoint location is recorded on screen as an orange dot. It can be selected, edited or deleted 

just like any other feature point. 

Managing S1 Waypoint Data 
 

S1 Waypoint information is stored in a JSON file on the device, and can be imported into GIS or to other 

file formats. In order to import into GIS, the file must first be copied off the device onto a network 

location known to ArcGIS. 

Assumptions: 

 Android Device with SD Card installed 

 USB cable 

 ArcGIS 10.2 or later installed on a PC or Citrix 

Copy Waypoint JSON File to Computer 

 Connect Device to computer via USB cable. 

 Using Windows Explorer, navigate to the following directory on your connected Android device.  

…\Card\Android\data\gov.s1.s1mobile\Edit_Data\Waypoints 
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 Right-click on the file waypoints.json and choose Copy from the menu.  

 Using Windows Explorer, navigate to a network location accessible to ArcGIS to paste the file. 

Click on Organize -> Paste to copy/paste the file into this directory. 

  

Import JSON File into GIS 

 Launch ArcMap 10.2 or later on PC or Citrix 

 Choose Geoprocessing Menu -> ArcToolbox -> Conversion Tools -> JSON -> JSON to Features 

o Input JSON  = the path to the file copied from the device 

o Output Feature Class = name of new feature class to be created (in an existing file 

geodatabase) 

 

 After tool has run, new layer will be added to ArcMap. 
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Deleting Waypoints on Device 

Waypoints can be deleted individually by selecting each on the map and choosing the Delete option 

from the Selection toolbar. Or alternatively, the entire waypoint file on the device can be cleared out. 

This might be desirable after a group of waypoints are exported to GIS. To do so, use Manage Map 

Layers. 

 Click on the Manage Map Layers icon. 

 

 Tap the current Edit Geodatabase icon, then long tap on the S1 Waypoints icon and choose 

Delete All Waypoints. This will clear all existing waypoints from the application. 

 

Advanced Data Collection Tools 
The advanced data collection tools can be found in the Edit Options button on the Edit Toolbar. 

 

Tapping this button presents a menu of options, not all functions are operational in the current release 

of S1 Mobile: 
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Nesting a Feature While Collecting another Feature 
While collecting a larger line or area feature, it may be desirable to “nest” a smaller feature inside of the 

larger one. To do so: 

 If in GPS Stream mode, pause streaming by tapping the Pause GPS Stream button 

 On Edit Toolbar, tap the Edit Options button 

 

 Choose Nest Feature option, then choose the type of new feature to be nested 

 Capture this nested feature in the manner of your choosing (GPS or drawing), save the nested 

feature’s geometry & attributes just like a normal feature 

 After capturing nested feature, resume capturing the original line or area feature by tapping 

either GPS Stream or Averaged Vertex button 

 Repeat process as necessary to capture additional “nested” features before saving the geometry 

& attributes of the original line or area feature. 

Buffer PG –GPS 
This feature is not implemented in this version of S1 Mobile 

Offset 
This feature is not implemented in this version of S1 Mobile 

Collect Settings 
This opens the S1 Options form, where users can change # of averaged positions & Vertex Interval 

settings. 

Copy Geometry  
This function allows the user to copy the geometry and attributes of a selected feature into a new, 

separate record, into the same layer or into a different layer in the same GDB. It is only available when 

an existing record is selected, not during new data collection. 

 The feature should already be selected and the Edit Feature button on the Selection Toolbar 

should already be enabled, if not do so 

 
 On Edit Toolbar, tap the Edit Options button 
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 Choose Copy Geometry option, then choose which layer the selected record is to be copied into 

 The attribute form for the chosen layer will appear; wherever the attributes fields match 

between the copied feature and the target layer, the existing attribute values will also be carried 

over. Fill out or change any relevant attribute fields, then tap Save to complete the copy action. 

Estimated Accuracy & Feature Level Metadata 
The S1 Mobile application can record a variety of metadata elements about the accuracy of collected 

and updated features, directly into the attribute field(s) of each record whenever GPS is used. The 

elements include: 

 Estimated GPS accuracy (in feet and meters) to 95% confidence interval to meet the National 

Standard for Spatial Data Accuracy (NSSDA) requirements 

 Quality of the GPS coordinate source used (No Fix, GPS, DPGS, RTK)  

If any of the following fields are part of the published feature service and appear in the GDB layer being 

collected or edited, the S1 Mobile application will automatically populate them when a feature is 

created or updated via GPS: 

 Field Name: ACCURACY_FT (double) 
 Field Name: ACCURACY_M (double) 
 Field Name: COORD_SRC (text, field length 7) 

When GPS averaging is employed during data capture, the stored estimated accuracy will reflect the 
average accuracy of the total number of positions. These are read-only attribute fields and cannot be 
directly edited by user on the device. 

 

If a feature is being updated via GPS, the following rules apply to accuracy field updates: 

 If a point and geometry is updated, the stored accuracy & coordinate source attributes are 
replaced with current values 

https://www.fgdc.gov/standards/projects/FGDC-standards-projects/accuracy/part3/chapter3
https://www.fgdc.gov/standards/projects/FGDC-standards-projects/accuracy/part3/chapter3
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 If a line or area and geometry are updated, the accuracy attribute is updated with a combination 
of the stored accuracy and the current accuracy, using a weighted average of the total # of old 
and new vertices. 

 If a line or area and geometry are updated, the coordinate source attribute is updated with the 
lowest source level obtained (GPS < DGPS < RTK) 

If the feature is collected via digitizing, these fields are never populated or updated. 

Navigation 
When the GPS has a position fix, users can set a navigation target at a designated location in the map 

view. 

 Long tap on screen to set a Navigation Target 

o A blue icon is placed at the location of the Navigation Target 

   
o A transparent Navigation Pane is displayed near the top of the map view. This pane 

provides distance and bearing values to the navigation target. 
o Distance value to target is displayed in feet or meters 

o Bearing value to target is displayed in degrees (True North) 

 

 Distance/bearing values change as the GPS position moves in relation to the Navigation Target 

o Distance value decreases when moving towards the target 

o Distance value increases when moving away from the target 

o Bearing degree value changes as the GPS positon moves 

 

 The application displays a toast at the bottom of the screen as the user approaches the 

navigation target 
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 The threshold for this alert is managed by the Navigation Alert Distance setting in S1 Options 

 Tap the Cancel Button to clear the Navigation Target 

 
 Long tap on screen to set a different Navigation Target 
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Tools 
General application tools can be accessed via the S1 Tools/Options button 

 

Measure Tool 
This tool provides the capability to measure distance or area by sketching in the Map View. This tool also 

allows a user to determine the length or area of an existing feature.   

Measure Distance or Area in Map View 

To measure a distance or area in the Map View tap on Tools/Options on the Application Toolbar 

 

 Select Tools from the list 

 Select Measure to open tool 
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 Tap on screen where measurement will begin (similar to digitizing a line or polygon) 

 Continue to Tap on screen until satisfied with measurement, length/distance measurement is 

reported at top of screen on the Measure Toolbar as additional vertices are added to sketch 

 Tap on Undo Vertex button to remove last vertex in the sketch measurement 

 

 Tap on Distance Mode to change tool from Distance to Area 

  

Display units can be changed to Metric or Statute in the Options menu under Tools/Options on 

the Application Toolbar 

 If application display units are set to Metric: 

o Distance is displayed in kilometers, unless measurement length is less than 0.10 

kilometer then meters are displayed 

o Area is displayed in hectares, unless area measurement is less than 0.50 hectares 

then switch to square meters 

 If application display units are set to Statute: 
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o Distance is displayed in miles, unless measurement length is less than 0.10 miles 

then feet are displayed 

o Area is displayed in acres, unless area measurement is less than 0.5 acres then 

switch to square feet 

 Tap on Cancel button    to exit Measure Tool  

Determine Length or Area of Selected Feature 

If a line or polygon feature is currently selected on screen, its length and area can be reported directly in 

the feature info window of a selected feature.  

 

The measure tool can be also used to report this information. To report length or area of a selected line 

or polygon map feature using the Measure tool: 

 Tap on Tools/Options on the Application Toolbar 

 

 Select Tools from the list 

 Select Measure to open tool 

The selected feature’s length or area will be reported at the top of the screen on the Measure toolbar 



 
 

S 1  M o b i l e  A p p l i c a t i o n  f o r  A n d r o i d  2 . 3  
 

Page 55 

 

Display units can be changed to Metric or Statute in the Options menu under Tools/Options on the 

Application Toolbar 

 If display units are set to Metric: 

o Distance is displayed in kilometers, unless measurement length is less than 0.10 kilometer 

then meters are displayed 

o Area is displayed in hectares, unless area measurement is less than 0.50 hectares then 

switch to square meters 

 If display units are set to Statute: 

 Distance is displayed in miles, unless measurement length is less than 0.10 miles then feet 

are displayed 

 Area is displayed in acres, unless area measurement is less than 0.acres then switch to 

square feet 

 Tap on Cancel button   to exit Measure Tool  
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S1 Application Options 
The S1 Options form allows user to configure common settings across the application. 

 

Number of Average Positions: this sets the default # of GPS positions that must be collected to create 

an averaged point feature or averaged vertex of a line or area feature when using the Average GPS 

button: 

 

Streaming Interval: This is the interval at which the application captures GPS vertices while in streaming 

mode. This value is either # of seconds or in distance traveled, depending on the value specified in the 

streaming type settings.  

Streaming Type: Time or Distance, this is the criteria that the streaming interval is based on. 

Streaming interval & type are used when collecting via the Begin Streaming button: 

 

Display Units: Metric or Statute (US). Will apply values across application, where units of measure are 

displayed.  
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Navigation Alert Distance: Threshold distance for alerting user that they are approaching a destination 

target. Units are specified by setting in S1 Options Display Units. 

Waypoints Visible: If checked, stored waypoints are visible in the map view. 

Accuracy Level: toggle GPS Position Toolbar estimated accuracy display between 68% (default) and 95% 

confidence interval. While most GPS receivers and data collection software display estimated accuracy 

statements only to a 50-68% confidence interval, the National Standard for Spatial Data Accuracy 

(NSSDA) requirements state reporting of estimated accuracy to a 95% confidence interval. 

Auto Pan GPS: if checked, map pans to keep current GPS location centered in middle of map. 

Coordinate Units: The coordinate system used by the application, this affects the format of XY values 

displayed on the GPS Toolbar as well as the XY information displayed in a selected feature’s information 

pop up.  

Log Off: AG4O user log in credentials are stored by the application. This button will log out the current 

user of the application, which allows a different person to log in. This capability is only available while 

device is connected to a network. 

Do not log out of application and then go to field and expect to log back into application from the field; 

if you have no network connectivity you will be unable to access the application until the device is back 

on network to perform log in.  

 

  

https://www.fgdc.gov/standards/projects/FGDC-standards-projects/accuracy/part3/chapter3


 
 

S 1  M o b i l e  A p p l i c a t i o n  f o r  A n d r o i d  2 . 3  
 

Page 58 

Creating & Sharing User Reference Maps 
This section describes how to create User Reference Maps via ArcMap for offline consumption with the 

S1 Mobile application.  In S1 Mobile, users can add a User Reference Map to display on top of the 

existing base map. This User Reference Map can be either a multi-scale ESRI tile package (.tpk) or a 

single geo-referenced GeoTIFF image file. User Reference Maps can be shared and downloaded to 

mobile devices via ArcGIS for Organization (AG4O) over Wi-Fi or cellular networks and can also be 

manually copied to a mobile device via Windows Explorer. 

Assumptions: 

 Access to ArcGIS Desktop 10.2.0 or later 

 Access to a government furnish Android device with a network connection, with S1 Mobile 1.0 

application installed 

 User name and password to your agency’s ArcGIS for Organizations (AG4O) website 

Creating a Tile Package 
Tile packages (.tpk) are a bundle of pre-rendered image tiles, generated for a specific area at several 

different scales that are wrapped into a single file. Unlike a paper map or a single digital image file, 

which presents a map at a single scale, a tile package can present a map at multiple scales to the user, 

providing appropriate layer representations for a variety of map scales.  

Below is an example of a tile package presenting tiles at different scales, images taken from ArcGIS 

Resource Center. 

    

Once they have been created, the tile package can be used to quickly render lightweight image files to 

applications. They can take consider time and resources to create however, so it is important to fine-

tune your ArcMap map document (.mxd) prior to turning it into a TPK for use on mobile devices. This 

document will attempt to provide some specific tips for optimizing your MXD prior to TPK generation. 

For more general information on tips for creating tile packages see this link: 

http://resources.arcgis.com/en/help/main/10.1/index.html#/Tips_for_creating_tile_packages/0066000

00456000000/ 

http://resources.arcgis.com/en/help/main/10.1/index.html#/Tips_for_creating_tile_packages/006600000456000000/
http://resources.arcgis.com/en/help/main/10.1/index.html#/Tips_for_creating_tile_packages/006600000456000000/
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Preparing the Map Document 

In order to create a tile package from ArcMap, one must first enable ArcGIS Runtime Tools. Click 

Customize -> ArcMap Options… -> Sharing tab and the check box to Enable ArcGIS Runtime Tools, then 

click OK. 

 

A map document’s data frame properties must: 

 Have its coordinate system set to WGS 1984 Web Mercator (auxillary sphere) 

 Have a datum transformation applied (if map contains NAD83 data) 

 Have a Extent Used By Full Extent Command defined to a specific extent 

 Utilize the Clip Options to “Clip to Shape” to define the outer edge of the map extent 

 Have the Frame Background color set to “No Color” 

It is recommended that you start using a new map document, rather than an existing one. Add only the 

layers needed to create this package. Set each of the layers’ properties, including minimum and 

maximum scales for both layer and label visibility. 

Set Data Frame Coordinate System & Datum Transformation 

 Go to View menu -> Data Frame Properties…  -> Coordinate System Tab 

 Expand Projected Coordinate Systems folder  

 Expand World folder 

 Select WGS 1984 Web Mercator (auxillary sphere) 
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 Click Transformations… button 

 Set as shown below (if there are NAD 83 layers in this maps) 

Click OK to close the transformations window, and OK to save changes and close Data Frame properties 

 

Set Full Extent Command and Clip to Shape 

 Zoom & pan map to the maximum extent desired in the output tile package. The farther zoomed 

out, the longer this process will take (and the larger the output file) so only zoom out to as far as 

needed. 

 Go to View menu -> Data Frame Properties…  -> Data Frame Tab 

 In the Extent Used By Full Extent Command, click Specify Extent button 



 
 

S 1  M o b i l e  A p p l i c a t i o n  f o r  A n d r o i d  2 . 3  
 

Page 61 

 

 Choose Choose Current Visible Extent and click OK 

 

 In the Clip Options, choose Clip to Shape and then click Specify Shape 

 

 Choose Current Visible Extent to clip to the current view, and then click OK.  

 

Alternatively, if you wanted to clip to a specific area (ex: a District or Forest boundary), you would first 

select that feature and return to this form and choose Outline of Features and then choose the Layer 

and Selected. This would be preferred, and would help to reduce the size of the tile package and 

processing time. 
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Set Map Document Properties 

 Go to File menu -> Map Document Properties 

 Fill in the Summary, Description, Tags sections, and optionally, click Make Thumbnail, and then 

click OK 

 

 Save Map Document and Close ArcMap 

Create Tile Package  

 Go to File menu -> Share As -> Tile Package… 

 Specify the location to save the tile package on the network 

 Click the Tile Format tab 
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  Check box to Package for ArcGIS Online/Bing Maps/ Google Maps 

  Set Tiling Format = PNG8 

 Set Level of Detail by moving the slider bar. The greater level of detail, the larger the tile 

package size and the longer it will take to generate the package. Try to keep the package under 

100MB in size.  

 Click the Item Description tab. 

 

 Populate the Required field sections in this form 

 Click Analyze.  A second window will appear, showing errors/warnings about your map 

document. Fix all Errors before proceeding.   

 Click Share to create the tile package. Depending on the level of detail you chose, this tool will 

run for several minute to several hours to complete. 
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Creating Geo-referenced Image File 
Unlike tile packages, which present a map at multiple scales, a geo-referenced image is a single image at 

a single map scale. These are very quick & easy to generate, however they may not be appropriate for 

viewing on the mobile device at all map scales. The supported geo-referenced image file format is the 

GeoTIFF file format. 

Preparing the Map Document 

A Map Document’s Data Frame properties must: 

 Have its coordinate system set to WGS 1984 Web Mercator (auxillary sphere) 

 Have a datum transformation applied (if map contains NAD83 data) 

 Have the Frame Background color set to “No Color” 

It is recommended that you start using a new map document, rather than an existing one. Add only the 

layers needed to create this image.  

Set Data Frame Coordinate System & Datum Transformation 

 Go to View menu -> Data Frame Properties…  -> Coordinate System Tab 

 Expand Projected Coordinate Systems folder  

 Expand World folder 

 Select WGS 1984 Web Mercator (auxillary sphere) 

 

 Click Transformations… button 

 Set as shown below (if there are NAD 83 layers in this maps) 

Click OK to close the transformations window, and OK to save changes and close Data Frame properties 
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 Save Map Document. 

Set Export Extent & Export Image 

 Zoom/pan map to the desired extent to export. Do not have a map scale greater than 1:500,000 

when exporting geo-referenced maps. In fact, it is recommended to have a map scale of 

1:100,000 or better (1:50,000, 1:24,000, 1:10,000) to achieve a readable image file. 

 Go to File -> Export Map… 

 Give the output file a name, choose the Save as Type = TIFF 

 Under the general tab, set the resolution = 150 dpi 

 

 Under the Format tab, Color Mode = 24-bit True Color, Compression = None, Background Color 

= No Color, check Write GeoTIFF Tags. 

 

 Click Save to export the current map view to a geo-referenced map. 
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Upload & Share Reference Maps to AG4O 
 Log into your Agency’s ArcGIS for Organization, by going to: 

https://www.arcgis.com/home/signin.html 

 Click My Content at top of web page. 

  

 Click Add Item -> from my computer 

 

 

 Click Choose File and browse to the location of the geo-referenced image or tile package you 

wish to upload. 

 Enter at least one Tag to identify your layer. 

 Click Add Item to add to your content on AG4O. 

 In AG4O, go to My Content, click on the name of your image layer to see its information.  

 Click the Share button on the content properties screen and place a check mark next to the 

groups you wish to share this layer with, and then click OK to commit the share modifications. 

 

 

https://www.arcgis.com/home/signin.html
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Now when using S1 Mobile application, users belonging to the group will be able to see and download 

this User Reference Map. For more info on this process, see Downloading User Reference Map to 

Device. 

Creating & Sharing Editable Feature Services 
This section describes how to publish and share a feature service for offline consumption with the S1 

Mobile application.  In the ESRI Runtime SDK, these downloaded feature services are known as runtime 

geodatabases (GDB).  In the S1 Mobile application, they are referred to as Edit Geodatabases (GDB). All 

of these terms are synonymous with the concepts described in this document. 

Assumptions: 

 Access to an enterprise relational geodatabase (RDBMS) running ArcSDE 10.2 or later, with 

database/schema owner privileges 

 Access to ArcGIS Server 10.2.2 or later (10.3 or later if data has related tables) that uses Token-

based authentication, with publishing rights 

 Access to a government furnish Android device with a network connection, with S1 Mobile for 

Android application installed 

 User name and password to your agency’s ArcGIS for Organizations (AG4O) website 

Loading Data into RDBMS 
Feature classes must be loaded into an enterprise geodatabase and configured to meet offline 

synchronization capability criteria outlined as outlined by ESRI.   

Data sets must: 

 Contain non-versioned datasets (versioned is supported in SDE 10.3 and higher) 

 Archiving must  be enabled on datasets 

 Datasets must include GlobalIDs 

 Relationship classes and attachments must use a GLOBALID primary key 
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For more info on these specifics, see: 

http://resources.arcgis.com/en/help/main/10.2/index.html#//0154000006m1000000 

Publishing Sync-Enabled Feature Service 
Add the data to a map using an editor account registered with ArcGIS Server, and prepare the data 

layers for publishing to ArcGIS Server.  For general information on preparing a map document for 

publishing, see this: 

http://resources.arcgis.com/en/help/main/10.2/index.html#//0154000003nt000000 

Before publishing the service, ensure that the coordinate system defined in the Data Frame properties 

has a known WKID value, not a custom value. If the coordinate system is based on a datum other than 

WGS84, ensure the proper datum transformation as well before publishing. 

 

When publishing the feature service, check the Feature Access capability and enable the CREATE, 

DELETE, QUERY, SYNC and UPDATE capabilities. 

If this ArcGIS Server is served by an external web adapter, it may be possible to access the feature 

service from outside the Agency network. If this is the case, only publish the service using an HTTPS 

connection; never use unsecured HTTP connections when publishing content that will be used to collect 

data.  

If it is hosted on an internal ArcGIS Server without an external web-adaptor, then the feature services 

will only be available on Agency networks or via VPN. 

If the feature service is accessible through an external web-adapter, the service should be secured to 

only allow authenticated users access to it. This is accomplished through the ArcGIS Server Manager 

Web interface.  If the service is secured, users will need to supply their Active Directory credentials 

before gaining access to the service. The service can be secured to all authenticated users or to a 

selected Active Directory group, if desired. Securing feature services that are externally exposed is highly 

recommended and is considered a best practice. 

http://resources.arcgis.com/en/help/main/10.2/index.html#//0154000006m1000000
http://resources.arcgis.com/en/help/main/10.2/index.html#//0154000003nt000000
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Add the Feature Service as AG4O Feature Layer 
Log into your Agency’s ArcGIS for Organization, by going to: https://www.arcgis.com/home/signin.html 

Click My Content at top of web page. 

  

Click Add Item -> From the web 

 

Enter the URL of your feature service. It should end in /FeatureServer 

If your feature service is secured, you will be prompted to enter your user name and password. Enter it, 

but choose the option for Do not store credentials with this service item.  

Enter at least one Tag to identify your layer. 

Click Add Item to add to your content on AG4O. 

https://www.arcgis.com/home/signin.html
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Share Feature Layer and Enable for S1 Mobile 
In AG4O, go to My Content, click on the name of your feature layer to see its information. If it is a 

secured feature service, you will be prompted to enter your AD user name and password. 

Click the Share button on the content properties screen and place a check mark next to the groups you 

wish to share this layer with, and then click OK to commit the share modifications. 

 

 

 

Now when using S1 Mobile application, users in the shared group will be able to see and download an 

edit geodatabase for this feature service. For more info on this process, see Download Edit GDB. 



 
 

S 1  M o b i l e  A p p l i c a t i o n  f o r  A n d r o i d  2 . 3  
 

Page 71 

 

Interacting with Hosted Feature Service Content in ArcMap 
Once records are synchronized back to the feature service, the service can be viewed in AGOL via a web 

browser, or the data can be viewed or edited in ArcMap. 

Adding Hosted Feature Service to ArcMap 

 File Menu -> Sign In 
 Enter your AG4O credentials, click Sign In 
 File Menu -> ArcGIS Online… 
 Click My Groups 
 Click on group name where service is shared 
 Find service, click Add  to add to ArcMap (if it says Open that is a web map & that is not what 

you are looking for) 

 
 

Once added to a map document, it can be used like any other layer in the map, with one exception: it 
cannot be directly edited. To edit the records of a hosted feature service, follow the instructions in the 
next section. 

Create a Local GDB Copy for Editing 

 Switch Table of contents to List by Drawing Order 

 
 

 Right Click on the Feature Service Name in ArcMap table of contents 
 Edit Features -> Create Local Copy for Editing 
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 A local file GDB edit replica is created in your roaming profile and added to map 
 Make your edits in normal ArcMap edit session, save edits, stop editing 

 
To synchronize your changes back with the service…. 

 In List by Drawing Order View: Right click on Feature Service name in table of contents -> Edit 
Features -> Synchronize Local Edits with Server 

 
 The map layers switch back to the feature service after synchronization occurs 

 
If you do just want a local copy for analysis but do not intend to edit the features: 

 In List by Drawing Order View: Right click on Feature Service name in table of contents -> Edit 
Features -> Disconnect Local Copy from Server 

 
This might be desirable if you would like a local GDB for distribution off network or for geoprocessing 

analysis. Just remember, all edits should be synchronized back to the hosted feature service. 
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Application Capabilities 
Below is a list of the planned capabilities of this application. Not all requirements are implemented in 

version 2.0 of this application.  

Functional Specifications 
Function Implementation Status 

Application runs on a modern smartphone platform Implemented 1.0 

Integrates with existing enterprise GIS (EGIS) infrastructure Implemented 1.0 

Is low cost and requires little training to operate Implemented 1.0 

Can display commercial and agency authoritative base maps Implemented 1.0 

Can display user-generated  reference maps Implemented 1.0 

Can display maps and collect data without connection to a cellular or WiFi network Implemented 1.0 

Allows the capture of GIS data features and attributes Implemented 1.0 

Allows for the tracking of who collected a feature and when it was collected Implemented 1.0 

Can capture feature linked photographs Implemented 1.0 

Feature edits and photographs can be synchronized directly back to GIS databases Implemented 1.0 

Spatial data can be captured via sketching on screen or via GPS Implemented 1.0 

GPS data can be averaged to improve accuracy Implemented 1.0 

Linear features can be captured via GPS streaming or via vertex averaging  Implemented 1.0 

While collecting one feature, a second feature can also be nested Implemented 1.0 

Estimated accuracy of GPS is reported on screen Implemented 1.0 

Can capture simple “waypoint” locations on device Implemented 1.0 

Ability to edit the geometry of existing GIS features Implemented 2.0 

Ability to duplicate or copy feature geometry and attributes Implemented 2.0 

Ability to repeat attributes from one feature to next Implemented 2.0 

Statistical estimation of spatial accuracy is stored with each feature edit Implemented 2.0 

Can interface with high accuracy (sub-meter) GPS receivers for precise spatial data 
collection 

Implemented 2.0 

Display GPS location in different coordinate systems Implemented 2.0 

User can set navigation targets and device will provide distance, direction and 
navigation alerts to the destination 

Implemented 2.0 

Related table data collection will be supported Implemented 2.0 

Measuring tools for reporting distance and area are provided Implemented 2.0 

Distance based GPS Streaming is supported when collecting lines and areas Implemented 2.0 

Feature edits of local geodatabase data set will be supported Planned 

Geo-tagged photos can be captured Planned 3.0 

Query tools will be provided for edit layers Planned 3.0 

Collection of new features via directional offsets Planned 3.0 

Capture a GPS Track log of where user goes with device Planned 3.0 

Ability to generate a polygon feature using a supplied buffer value Planned 

Custom edit forms will be supported Planned 

 

Technical Specifications 
 Android OS, version 4.0 “Ice Cream Sandwich” or later 
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 ESRI Runtime for Android SDK 10.2.8 

 Wi-Fi network availability for map download and synchronization 

 Internal GPS receiver or supported external Bluetooth receiver 

 Integrated digital camera (for capturing images) 

 ArcGIS Server 10.2.2 or later feature services for edit data download and synchronization 

 Affiliation with BLM, USFS or NPS ArcGIS for Organization account 

Supported Hardware 
 Samsung Galaxy S3, S4, S5, S6 smartphones 

 Samsung Galaxy Tab 3, 4, S2, & Active  tablets 

 Garmin Monterra handheld 

 Cedar CT4 ruggedized handheld 

 Cedar CT7 ruggedized tablet 

 Trimble R1 bluetooth receiver 

 Trimble Geo 6000 & 7x handheld receiver *** 

 Garmin GLO bluetooth receiver 

***Due to a Trimble business decision, their Geo 6000 & Geo 7x receivers are incapable of correctly 

exporting estimated accuracy values to external applications. While these devices do collect very 

accurate spatial locations, the estimated accuracy values provided in the S1 Mobile application will not 

reflect this level of accuracy due to Trimble software limitations imposed on this hardware. 

Known Hardware Limitations 
 # of Satellites listed on GPS toolbar are incorrect when using Samsung Galaxy S2 

 GPS Streaming performance may become impaired when more than 5000 streaming positions 

are captured without saving feature 

 Last known GPS location may appear as current GPS location when GPS is first activated, which 

may not reflect actual current GPS location until a new position fix is obtained 

 External GPS Receiver support requires the ability to enable Mock Locations, which is blocked by 

BLM MaaS360 Policy. Users must submit a Remedy ticket to obtain a waiver to enable this 

functionality on the BLM government furnished equipment (GFE). 

 When using Bluetooth receivers, if Bluetooth connection is lost (ex: due to GPS receiver power 

failure) the GPS status bar may continue to report the last known coordinates. 

 When using Bluetooth receivers, if switching between different Bluetooth receivers a restart of 

the device may be necessary in order to receive correct GPS information from the second 

Bluetooth receiver. 
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Installation 
The app is not found in the Google Play Store, installation will typically be handled remotely via your 

agency. If the device is not a government furnished device managed by mobile device management 

software, the application must be manually downloaded to device and installed. 

BLM Government Furnished Device 
To request the application be published to your BLM device, submit a Remedy Help Desk Ticket. Request 

Steps: 

1. IT Services -> Phone, Mobile Device, Network Services -> Mobile Device Support -> Request Now 

2. “What do you need help with?” -> choose Mobile App Deployment to Device 

3. “Select the Mobile App” (pick list) -> choose S1 Mobile for Android from pick list 

4. Provide user email address associated with device 

5. Provide device model name under Device Name 

Once the ticket is completed, the application will be pushed to the device via MaaS360 device 

management software. 

Install S1 Mobile application via MaaS360 
 Applications -> MaaS360 

 

 MaaS360 interface appears. 

 

 Tap on App Catalog icon 

 

 

http://1800blmhelp.blm.gov/
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 Tap Refresh button at right of screen to update App Catalog  

 

 Under the “All” tab, tap Install and then Download. This will install the application. 

 

 After application is installed, it can be launched from the list of Android applications. 

Upgrade S1 Mobile application via MaaS360 
Once the application has been deployed to your BLM government furnished device, application updates 

are available via MaaS360, and no help desk ticket is required to receive them. You must initiate the 

upgrade process yourself from within the MaaS360 application. 

 Applications -> MaaS360 

 

 MaaS360 interface appears. 

 

 Tap on App Catalog icon 

 

 Tap Refresh button at right of screen to update App Catalog  
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 Under the “All” tab, next to S1 Mobile application tap Update, then Download and finally 

Install. This will install the updated application. 

 

 After application is upgraded, it can be launched from the list of Android applications. 

 

USFS Government Furnished Device 
If this is a USFS government furnished Android device, it must first be enrolled with the USDA Mobile 

Iron before installing the S1 Mobile for Android application. If your device is already configured with 

Mobile Iron, please skip to next section. 

Configure device with Mobile Iron 

1. Submit a USFS Customer Help Desk (CHD) ticket to request that your device be enrolled in 

Mobile Iron and that you be sent a PIN code via email to configure Mobile Iron on device. If the 

device was purchased via Technical Approval (TA), you may need to indicate this to CHD; 

otherwise they will want to know the name of the carrier the device was purchased from. CHD 

Help Desk Phone # 866-945-1354 

2. Insert micro-SD card if you plan to use one 

3. Charge battery to at least 80%, then turn device on 

4. Follow CHD instructions (internal FS link) for setting up Android device 

5. Connect to cell data network or to public WiFi 

6. Check for and download OS Updates: Settings -> General tab -> About Device -> Software 

Update - > Update Now 

7. Once you have received your PIN via email, follow CHD instructions (internal FS link) for 

configuring device with Mobile Iron and Touchdown  

8. (Optional) Submit request (internal FS link) to allow device connection to FS WiFi. You only need 

to do this if you have FS WiFi in your office 

9. (Optional) Connect to FS Wifi via CHD Instructions (internal FS link) 

Once the device is configured with Mobile Iron, the application will be available to all USFS users via 

Mobile Iron Mobile@Work device management software. 

Install S1 Mobile application via Mobile Iron Mobile@Work 

 Launch Mobile Iron Mobile@Work app on device 

https://ems-team.usda.gov/sites/fs-r06-s1gis/mobile-gis/Shared%20Documents/KBA00086277+FS+Android+Initial+Setup.docx
https://ems-team.usda.gov/sites/fs-r06-s1gis/mobile-gis/Shared%20Documents/KBA00085132+FS+Android+Configure+to+receive+Forest+Service+email.docx
https://ems-team.usda.gov/sites/fs-cio-edsts/Lists/MobileWiFiAccessRequests/NewForm.aspx?Source=https://ems-team.usda.gov/sites/fs-cio-edsts/WebPages/Mobile-WiFi-Access-Requests.aspx
https://ems-team.usda.gov/sites/fs-r06-s1gis/mobile-gis/Shared%20Documents/KBA00085080+FS+Mobile+Connecting+to+the+Forest+Service+wireless+network.docx
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 In upper left corner of screen tap menu button  and choose Apps@Work 

 

 Under the FEATURED tab, tap the S1 Mobile – Free icon 

 

 Tap the blue Request button to initiate download 

 

 App will begin to download, progress shown on screen 
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 After download and installation is successful, Apps@Work will show the S1 Mobile as 

INSTALLED 

 

 Launch the application using the application icon that is created on the main screen of the 

device  

 

Upgrade S1 Mobile application via Mobile Iron Mobile@Work 

Once the application has been deployed to your USFS government furnished device, application updates 

are provided automatically via Mobile Iron. You must initiate the upgrade process yourself as shown 

below. 

 Launch Mobile Iron Mobile@Work app on device 

 

 In upper left corner of screen tap menu button  and choose Apps@Work 

 

 On the Features tab, tap the S1 Mobile – Update icon 

  

 Tap the blue Update button to initiate download 

 App will begin to download, progress shown on screen 
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 After download and installation is successful, Apps@Work will show the S1 Mobile as 

INSTALLED 

 

 Launch the application using the application icon that is created on the main screen of the 

device  

 

 

Non- Government Furnished Device 
If the device is not a government furnished device managed by mobile device management software, 

the application must be manually downloaded to device and installed. Because it is not coming from the 

Google Play Store, the device must also be set to allow installation of unknown apps. If you have an 

older build installed on device, you may need to first uninstall it before installing a new build. 

 Open Chrome application (or other Internet Web Browser) on device and enter the following 

URL to initiate download to the device: 

http://www.blm.gov/or/gis/files/mobile/S1%20Mobile.apk  -or- 

Scan this QR code using a QR Reader application on your device to initiate download: 

http://www.blm.gov/or/gis/files/mobile/S1%20Mobile.apk
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If downloading the application to a Samsung Galaxy S5 device, it may be necessary to first install FireFox 

and choose it as the browser to download the file; the Chrome browser has been known to be 

unsuccessful in downloading installation packages on the Galaxy S5 device. 

 After file has finished downloading to device, navigate to its location (typically the Downloads 

folder) on the device using the My Files or File Explorer application on the device (app may be 

called by a different name depending on device model) and tap on the S1 Mobile.apk file to 

start the install 

a. If you get this message: 

 

b. Tap Settings -> Security-> Unknown Sources. Put check box next to “Unknown Sources” 

 

c. Uncheck “Allow initial installation only” tap OK 
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d. If installation doesn’t automatically proceed, return to the APK and tap on it again to re-

initiate the installer 

 Step through the app installation screens 

a. Click Install 

 

 

 

b. If you receive the following message, tap Accept 
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c. Click Open to open the app 

 

Uninstalling Application 
It is not typically necessary to uninstall the application. However, should you decide to manually 

uninstall the application, be aware that doing so will also delete the contents of the S1 Mobile 

application directory; this includes both the internal storage and the SD card storage location. Before 

manually uninstalling the application, back up and downloaded application content (base maps, user 

reference maps, offline geodatabases) from the following directories: 

…\Card\Android\data\gov.s1.s1mobile 

…\<Device>\ Android\data\gov.s1.s1mobile 
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External Bluetooth GPS Receiver Support 
The S1 Mobile application can also feed GPS measurements from supported external GPS receivers via 

Bluetooth to provide high accuracy location information to the application’s map view. This may be 

desirable if the estimated accuracy of the device’s internal GPS does not meet data accuracy 

requirements or if the Android device does not possess its own internal GPS receiver.  

Generally, to use external receivers with Android devices, the following steps must be performed: 

1. Turn on Bluetooth on Android device and on external receiver 

2. Pair external receiver with device via Bluetooth 

3. Enable Mock Location setting in Android developer options 

4. Activate external GPS within application 

Some these steps can be accomplished from directly within the S1 Mobile application when using 

supported external GPS receivers, which include: 

 Trimble R1 bluetooth receiver 

 Trimble Geo 7x handheld receiver 

 Garmin GLO bluetooth receiver 

Other models may also function with the app, but steps to pair may be different than what is described 

below for unsupported receivers. 

Configure Location Settings 
In order to ensure that you are only receiving measurements from the device’s GPS receiver and not 

from Android network location services, one should set the Android Location setting to GPS Only. The 

Improve accuracy setting also needs to be disabled to prevent the device from attempting to improve 

accuracy by using Wi-Fi and Bluetooth scanning.  

Use the appropriate method below depending on the operating system of the device. 

Android Operating Systems (version 5 and newer) 

 On device, go to Android Settings-> Location 
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 Tap Mode, set Location method to GPS Only 

 

 Tap Back button at top left of screen next to Location method to return to Location settings.  

 

 Tap Improve accuracy  

 

 Verify both Wi-Fi scanning and Bluetooth scanning are toggled OFF 
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Older Android Operating Systems (version 4) 

 On device, go to Android Settings-> Connections-> Location 

 

 Tap Mode, set Location to GPS Only 

 

Configure Date and Time Settings 
The S1 app checks the location time stamp against the Android system time to determine if the position 

being provided is an old or new location. The time stamp and system time must be in sync for the 

Bluetooth GPS to work correctly. Check the box next to Automatic date and time as well as Automatic 

time zone to enable this functionality. These settings enforce the device’s date, time, and time zone to 

be provided automatically by the network.   

Use the appropriate method below depending on the operating system of the device. 

Android Operating Systems (version 5 and newer) 

Before going to the next step, it is important to be connected to a Wi-Fi or 4G network. This ensures the 

device’s time is automatically set based on the Wi-Fi or 4G network. 

 On device, go to Android Settings-> Date and time 
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 Tap Check box so there is a green check next to Automatic date and time and Automatic time 

zone 

 

Older Android Operating Systems (version 4) 

Before going to the next step, it is important to be connected to a Wi-Fi or 4G network. This ensures the 

device’s time is automatically set based on the Wi-Fi or 4G network. 

 On device, go to Android Settings-> General->  Date and time and verify settings are updated 
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Enable Developer Options and Mock Locations 
To use the Bluetooth GPS capability of the S1 app a few settings must be configured so the device can 

communicate with the Bluetooth GPS receiver.  The first step is to enable Developer Options on the 

device.  Enabling this option allows the device to use Mock Locations. Mock Locations is necessary in 

order for the Bluetooth GPS receiver location to be used instead of the device’s internal GPS location.  

If you are unable to enable setting this due to BLM MaaS360 policy restriction, you must submit a 

Remedy help desk ticket in order to enable this setting: IT Services -> Mobile Device Support -> Request 

Now -> “What do you need help with?”: Device Setup (MaaS360, Google Mail etc) -> “Do you need to 

change the device setup plan (MaaS360)?”: Yes -> “Select the setup plan”: GIS Device (Enable Mock 

Locations – Android Only). 

Use the appropriate method below depending on the operating system of the device. 

Android Operating Systems (version 5 and newer) 

 On device, go to Android Settings-> About phone 

 Tap on Build number repeatedly until a prompt appears indicating Developer options has 

been enabled 

 

 Tap Back button at top left of screen next to About phone to return to Settings 

 

 Tap Developer options 

 

 Tap OFF toggle to enable Developer options 
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 Developer options are now turned on 

 

 Scroll down and tap Mock location app 

 

 Tap S1 Mobile to select app 

 

 Mock location app is now set to S1 Mobile 

 

Older Android Operating Systems (version 4) 

 On device, go to Android Settings-> About phone 

 Tap on Build number repeatedly until a prompt appears indicating the device has Developer 

options enabled 
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 Tap Back button at top left of screen next to About phone to return to Settings.  

 

 Tap Developer options 

 

 Make sure the Developer options are turned on  

 

 

 Tap Check box so there is a green check to enable allow mock locations  

 

Pairing Trimble R1 Receiver 
Device is a sub-meter (in open canopy) receiver, capable of tracking GPS & GLONASS satellites, and can 

receiver WAAS and RTK corrections. 

Trimble R1 documentation: http://www.trimble.com/globalTRL.asp?nav=Collection-109386 

 Activate GPS should be turned off in S1 Mobile application 

 Turn on power to Trimble R1 

http://www.trimble.com/globalTRL.asp?nav=Collection-109386
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Pairing Device for First Time 

 First time pairing device, after powering Trimble R1 device on press & hold power button until 

rapidly flashing blue light appears, now device is visible to other devices for 60 seconds for 

pairing purposes 

 In S1 Mobile app, tap Tools/Options button 

 

 Tap Connect to Bluetooth GPS 

   

 If Allow Mock Locations is not enabled on Android device, will be prompted to turn on. Place 

check mark in box as shown below, then use back button on device to return to S1 Mobile app.  

If you are unable to enable setting this due to BLM MaaS360 policy restriction, you must submit a 

Remedy help desk ticket: IT Services -> Mobile Device Support -> Request Now -> “What do you 

need help with?”: Device Setup (MaaS360, Google Mail etc) -> “Do you need to change the device 

setup plan (MaaS360)?”: Yes -> “Select the setup plan”: GIS Device (Enable Mock Locations – 

Android Only). 

Once waiver is granted, return to these instructions and continue configuration of receiver. 

 

 If Android Bluetooth is off, respond Yes to turn on Bluetooth, then return to Tools/Options 

button and tap Connect to Bluetooth GPS to continue 
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 Tap Pair a Device 

  

 Android Bluetooth Settings appear. Tap Scan if device is not listed under Available Devices; if it 

still doesn’t appear after scanning, hold the power button down on the receiver for several 

seconds until blue light flashes rapidly (this puts device back into discoverable mode for 60 

seconds), then scan again. The default name of Trimble R1 receivers is 

GNSS:<last5digitsofserial#> (ex – GNSS:54735). 

 

 If device is listed under Available Devices, tap it to pair with Android device 

 When pairing is successful, the device name will be listed under Paired Devices. Tap the device’s 

Back button to return to S1 Mobile. 
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Enable Real-time Correction (WAAS/RTK) Settings 

By default, the R1 is set to only use autonomous, uncorrected GPS positions to obtain a position fix. It 

may be desirable however to enable the device’s ability to use real time corrections in the position fix. 

These corrections could come from WAAS (free) or RTK (paid subscription) signals. The device is 

configured using a separate application, called GNSS Status. 

 In S1 Mobile app, tap Setup Trimble Realtime 

 

 Google Play Store Opens, if app is not already installed, tap Install to install it on device, 

otherwise tap Open. 

 

 At bottom of screen , choose Select New Receiver 

 Choose the R1 from the list (ex – GNSS:54735), tap the connect icon 
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 App connects to device, tap GNSS Status in upper left corner, then choose Real-time Config 

 

 If primary source = Uncorrected, select EDIT in upper right corner, tap on the Primary Source 

type and change to SBAS, this is WAAS in the United States. Then tap SAVE. 

 Exit GNSS Status app 

 Restart the device to clear connection with GNSS Status app 

Enable NMEA Output Settings 

By default, the R1 does not output the necessary NMEA strings required for other applications to receive 

estimated accuracy values from the receiver. These NMEA strings can be enabled via the GNSS Status 

application. In order to enable NMEA output on R1 receiver, the receiver must have firmware version 

5.03 or higher and GNSS Status app must be version 2.0.7 or higher.  

 It is assumed this application is still open from the previous step and that receiver is paired with device, 

if not launch the application and pair the device as shown in previous section. 

 Tap GNSS Status in upper left corner, then choose NMEA Settings 

 

 Under Available, tap GGA and GST to send them to the Selected side of screen 
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 Tap Apply to Receiver 

 Under Select Port, tap SPP1 

 

 Tap Save 

 Close GNSS Status application 

Pairing Trimble Geo 7x Handheld 
Device is a sub-meter (in open canopy) receiver, capable of tracking GPS & GLONASS satellites, and can 

receiver WAAS and RTK corrections. Is a dedicated GPS receiver and data recorder, but its GPS signal 

stream can be output via Bluetooth and fed into an external data recorder (like an Android device). 

Doing so requires the installation of extra configuration software on the Geo Series device. 

Trimble Geo 7x documentation: http://www.trimble.com/globalTRLTAB.asp?Nav=Collection-85271 

http://www.trimble.com/globalTRLTAB.asp?Nav=Collection-85271
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 Activate GPS should be turned off in S1 Mobile application 

 Turn on power to Trimble Geo 7x 

 Windows Mobile Device Center (WMDC) must be installed on local PC 

Setup: Install & Configure Software on Geo 

 Download GPS Controller 2.70 & install 

o Download this file to PC, then copy to Geo via WMDC : 

\\blm\dfs\or\egis\projects\oso\Mobile_GIS\Android_Runtime_Project\BT_Receiver_Stu

ff\ Trimble GPS Controller 2.70.PPC600_StrongARM-XScale.PPC600_StrongARM-

XScale.cab 

o Using File Explorer on Geo, navigate to location of file, tap on it to run it. 

o Follow install instructions, accepting all defaults 

 Download GPS Connector & install (only for Geo6000, already installed on Geo7x):  

o Download this file to PC, then copy to Geo via WMDC : 

http://trl.trimble.com/dscgi/ds.py/Get/File-632978/GNSS%20Connector%20v1.2.1.CAB 

o Using File Explorer on Geo, navigate to location of file, tap on it to run it. 

o Follow install instructions, accepting all defaults 

 Launch & configure GPS Controller (tap Windows Start Menu-> GPS Controller): 

 

 Choose Setup 

 

  Tap GNSS Status 

http://trl.trimble.com/dscgi/ds.py/Get/File-632978/GNSS%20Connector%20v1.2.1.CAB
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 Set NMEA Output = On, then tap wrench icon 

 

 Set Output interval = 1s, ensure only GGA is checked, and then tap Done. 
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 Tap Real-time Setttings, set Choice 1 = Integrated SBAS, and then tap Done 

 Tap Exit 

 

 Turn on Trimble BT: Tap Windows Start Menu -> Settings -> Bluetooth 

 

 Tap Mode Tab -> Check Turn on Bluetooth, then tap OK 
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Setup: Create Bluetooth Pairing Between Geo & S1 Device 

 In S1 Mobile app, tap Tools/Options button 

 

 Tap Connect to Bluetooth GPS 

 

  

 If Allow Mock Locations is not enabled on Android device, will be prompted to turn on. Place 

check mark in box as shown below, then use back button on device to return to S1 Mobile app.  

If you are unable to enable setting this due to BLM MaaS360 policy restriction, you must submit a 

Remedy help desk ticket, requesting : “Allow Mock Location policy exception waiver on Android 

device to allow connection of external GPS receiver to mobile device in support of high accuracy 

field data collection.” Once waiver is granted, return to these instructions and continue 

configuration of receiver. 
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 If Android Bluetooth is off, respond Yes to turn on Bluetooth, then return to Tools/Options 

button and tap Connect to Bluetooth GPS to continue 

 

 

 Tap Pair a Device 

  

 Android Bluetooth Settings appear. Tap Scan if device is not listed under Available Devices; if it 

still doesn’t appear after scanning, hold the power button down on the receiver for several 

seconds until blue light flashes rapidly (this puts device back into discoverable mode for 60 

seconds), then scan again. The default name of Trimble Geo receivers is Geo<uniqueserial#> (ex 

– Geo5431443388). 

 

 If device is listed under Available Devices, tap it to pair with Android device 

 When prompted, enter 0000 and tap OK 
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 On Trimble device, when prompted tap Yes to add the Android device to your Geo’s device list 

 

 Enter 0000 in passcode box then tap Next 
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 After seeing a Device Added message similar to the one below, tap Done 

 

 On the Android device, when pairing is successful, the device name will be listed under Paired 

Devices. Tap the Android device’s Back button to return to S1 Mobile. 

 

Activate Bluetooth NMEA GPS Output on Geo 

Assumption is that Geo’s Bluetooth is already turned on, if not follow instructions from earlier step to 

turn on. The NMEA GPS Output step outlined here must be verified before each attempt to connect to 

Bluetooth GPS in S1 Mobile application. 

 Turn on GNSS Connector: Tap Windows Start Menu -> Settings -> Connections -> GNSS 

Connector 

 

 Choose Bluetooth (COM9) from list, your exact COM port # may differ from these instructions 
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 Tap Connect button 

 

App must keep running, do NOT tap OK or the app will exit and the Bluetooth connection will be lost. It 

is alright to tap device’s green home button to minimize application, but do NOT tap OK 

Optional: It may be desirable to view the Geo’s GPS Skyplot while its GPS stream is being fed to the S1 

Mobile application via Bluetooth. If so, the GPS Controller application can be launched. 

 On Geo, launch GPS Controller, tap Windows Start Menu-> GPS Controller: 
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 Tap SkyPlot from menu, GPS information will appear on screen as satellites come in contact 

with the Geo. 

Due to restrictions imposed by Trimble software on Geo Series devices, the estimated accuracy value 

displayed in GPS Controller may not match the value provided to S1 Mobile application via Bluetooth. 

The most correct value will be found in the GPS Controller application. 

 

Pairing Garmin GLO Bluetooth Receiver 
Device is a 2-5 meter (in open canopy) receiver, capable of tracking GPS & GLONASS satellites, and can 

receive WAAS corrections. 

Garmin GLO Documentation: http://static.garmin.com/pumac//GLO_Instruc_Web_ML.pdf 

 Activate GPS should be turned off in S1 Mobile application 

 Turn on power to GLO 

 First time pairing device: after powering device on LED will slow flash blue, this means searching 

for mobile devices, if no pairing occurs after several minutes, Bluetooth will turn off 

automatically. Users should turn device off and on to turn Bluetooth back on if this occurs. 

 In S1 Mobile app, tap Tools/Options button 

 

 Tap Connect to Bluetooth GPS 

 

  

 If Allow Mock Locations is not enabled on Android device, will be prompted to turn on. Place 

check mark in box as shown below, then use back button on device to return to S1 Mobile app.  

If you are unable to enable setting this due to BLM MaaS360 policy restriction, you must submit a 

Remedy help desk ticket, requesting : “Allow Mock Location policy exception waiver on Android 

device to allow connection of external GPS receiver to mobile device in support of high accuracy 

http://static.garmin.com/pumac/GLO_Instruc_Web_ML.pdf
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field data collection.” Once waiver is granted, return to these instructions and continue 

configuration of receiver. 

 

 If Android Bluetooth is off, respond Yes to turn on Bluetooth, then return to Tools/Options 

button and tap Connect to Bluetooth GPS to continue 

 

 

 Tap Pair a Device 

  

 Android Bluetooth Settings appear. Tap Scan if device is not listed under Available Devices; if it 

still doesn’t appear after scanning, hold the power button down on the receiver for several 

seconds until blue light flashes rapidly (this puts device back into discoverable mode for 60 

seconds), then scan again.  

 

 If device is listed under Available Devices, tap it to pair with Android device 
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 When pairing is successful, the device name will be listed under Paired Devices. Tap the device’s 

Back button to return to S1 Mobile. 

 

 

Connecting to Paired Bluetooth Receiver in S1 Mobile 
It is assumed that the both devices (Android & GPS receiver) are powered on & have Bluetooth turned 

on, Mock Location has been enabled on the Android device and both devices have been previously 

paired. If connecting a Geo Series device, it is also assumed that GNSS Connector has been activated on 

that device. 

 Launch S1 Mobile, if not already open 

 In S1 Mobile app, tap Tools/Options button 

 

 Tap Connect to Bluetooth GPS 

  

 Tap List Paired Devices 
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 Choose the preferred device from the list of paired devices to connect  

 

 Activate GPS icon is replaced in the application by the Activate Bluetooth GPS icon 

 

The connection to the Bluetooth device is being initialized, while this connection is being made, the GPS 

Status bar will display the following message. When it disappears, Activate Bluetooth GPS can then be 

tapped to turn on GPS location. Depending on the model of GPS receiver, this process can take several 

seconds to several minutes. Be in an area with optimal sky visibility to minimize the wait time. 

 

 Once initialization is complete, tap Activate Bluetooth GPS to enable GPS location from the 

connected Bluetooth receiver 

 

Disconnect Bluetooth Receiver/Return to Internal GPS 
 If GPS Location is currently on, tap Activate GPS to turn off 

 Tap Abort Bluetooth GPS to disconnect the Bluetooth GPS receiver 

 

 If Activate GPS button is pushed now, application will use internal GPS instead of Bluetooth GPS 
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If the Bluetooth pairing was made with a Geo Series device, consider also disconnecting the NMEA 

GPS output stream on the Geo: tap Windows Start Menu -> Settings -> Connections -> GNSS 

Connector -> Disconnect 

 

 


	About
	Launching Application
	Logging into Application
	Downloading Default Base Map

	Application Interface
	Application Toolbar
	Activate GPS
	Collect Features
	Manage Map Layers
	Tools/Options Menu
	About S1 Menu

	Downloading Content
	Base Maps
	Download ESRI Base Maps
	Download Agency (BLM or USFS) Base Map

	User Reference Map
	Downloading User Reference Map to Device
	Copy User Reference Map to Device via Side Loading
	Copy User Reference Map to Mobile Device
	Add User Reference Map to Application Map View


	Download Edit Geodatabase (GDB)
	About Edit GDB Extent
	Downloading Edit GDB to Device
	Sync Data Edits to Server


	Managing Downloaded Content in Map View
	Switch Current Content in Map View
	Remove Layer from Map and Delete from Device

	Collecting New Features
	Collecting New Point Feature via GPS
	Collecting New Point Feature via Digitizing/Draw on Screen
	Collecting New Line or Area Feature via GPS
	GPS Streaming
	GPS Averaged Vertex
	GPS Toggle between Stream & Averaged Vertex
	Collecting New Line/Area Feature via Digitizing/Draw on Screen

	Repeating Attributes
	Related Records Data Entry

	Editing Existing Features
	Edit Mode Toolbar
	Editing Feature Geometry
	Editing Point Geometry
	Via GPS
	Via Digitizing Manually on Screen

	Editing Line or Polygon Geometry
	Via GPS
	Via Digitizing Manually on Screen


	Editing Feature Attributes

	Collecting Photo Attachments
	Collecting Photo Attachments
	Managing Existing Photo Attachments

	S1 Waypoints
	Collecting S1 Waypoint
	Managing S1 Waypoint Data
	Copy Waypoint JSON File to Computer
	Import JSON File into GIS
	Deleting Waypoints on Device


	Advanced Data Collection Tools
	Nesting a Feature While Collecting another Feature
	Buffer PG –GPS
	Offset
	Collect Settings
	Copy Geometry

	Estimated Accuracy & Feature Level Metadata
	Navigation
	Tools
	Measure Tool
	Measure Distance or Area in Map View
	Determine Length or Area of Selected Feature


	S1 Application Options
	Creating & Sharing User Reference Maps
	Creating a Tile Package
	Preparing the Map Document
	Set Data Frame Coordinate System & Datum Transformation
	Set Full Extent Command and Clip to Shape
	Set Map Document Properties

	Create Tile Package

	Creating Geo-referenced Image File
	Preparing the Map Document
	Set Data Frame Coordinate System & Datum Transformation
	Set Export Extent & Export Image


	Upload & Share Reference Maps to AG4O

	Creating & Sharing Editable Feature Services
	Loading Data into RDBMS
	Publishing Sync-Enabled Feature Service
	Add the Feature Service as AG4O Feature Layer
	Share Feature Layer and Enable for S1 Mobile
	Interacting with Hosted Feature Service Content in ArcMap
	Adding Hosted Feature Service to ArcMap
	Create a Local GDB Copy for Editing


	Application Capabilities
	Functional Specifications
	Technical Specifications
	Supported Hardware
	Known Hardware Limitations

	Installation
	BLM Government Furnished Device
	Install S1 Mobile application via MaaS360
	Upgrade S1 Mobile application via MaaS360
	USFS Government Furnished Device
	Configure device with Mobile Iron

	Non- Government Furnished Device

	Uninstalling Application
	External Bluetooth GPS Receiver Support
	Configure Location Settings
	Android Operating Systems (version 5 and newer)
	Older Android Operating Systems (version 4)

	Configure Date and Time Settings
	Android Operating Systems (version 5 and newer)
	Older Android Operating Systems (version 4)

	Enable Developer Options and Mock Locations
	Android Operating Systems (version 5 and newer)
	Older Android Operating Systems (version 4)

	Pairing Trimble R1 Receiver
	Pairing Device for First Time
	Enable Real-time Correction (WAAS/RTK) Settings
	Enable NMEA Output Settings

	Pairing Trimble Geo 7x Handheld
	Setup: Install & Configure Software on Geo
	Setup: Create Bluetooth Pairing Between Geo & S1 Device
	Activate Bluetooth NMEA GPS Output on Geo

	Pairing Garmin GLO Bluetooth Receiver
	Connecting to Paired Bluetooth Receiver in S1 Mobile
	Disconnect Bluetooth Receiver/Return to Internal GPS


